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1 Einleitung

Diese Anleitung beschreibt die Installation, die Konfiguration und die Nutzung der
Zahlungsmoduls fir OpenCart und Payunity.

Bevor Sie mit der Installation beginnen kdonnen, stellen Sie sicher, dass Sie im Besitz aller
notwendigen Daten sind:

® Benutzername und Passwort zum Login des Backends von PayUnity
® OpencCart Zahlungsmodul von sellxed.com/shop
® 7ugangsdaten zu Ihrem Server und Shop

Falls Sie noch nicht im Besitze eines Vertrags mit Payunity sind, konnen Sie diesen gerne auch
direkt durch uns beziehen.

Beachten Sie, dass Sie fiir unsere Plugins mindestens die PHP Version 5.6 verwenden mdssen.
PHP 8 oder hoher wird derzeit nicht unterstitzt.

1.1 Ablauf der Installation

In diesem Dokument erhalten Sie alle Informationen, welche flr die Installation des Moduls
notwendig sind. Fur die Inbetriebnahme des Moduls sollten Sie die einzelnen Punkte der
Checkliste strikt befolgen. Nur so kann ein sicherer Einsatz in Ubereinstimmung mit allen
Sicherheitsregularien gewahrleistet werden.
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1. Konfiguration der Testoberflache anhand der Integrationsdaten von PayuUnity. Sie finden
die Tetplattform unter https://test.payunity.com/bip/login

2. Konfiguration der Grundeinstellungen des Zahlungsmoduls

3. Konfiguration der Zahlungsarten

4. Durchfihren einer Testbestellung anhand der beigelegten Testdaten am Ende dieses
Dokuments

5. Sofern der Test erfolgreich verlaufen ist, erfolgt die Konfiguration der Live Daten in Ihrem
Shop. Mit den erhaltenen Zugangsdaten kGnnen Sie sich in der Live Umgebung einloggen:
https://payunity.com/bip/login

Installationsservice

Unsere Zahlungsmodule sind standardmadssig so vorkonfiguriert, dass die Installation
gleich nach dem Eintragen der bendtigten Keys funktionieren sollte. Sollten Sie einen
Setting aus der Konfiguration des Moduls nicht kennen, konnen Sie sich gerne mit
unserem Support in Verbindung setzen.

Unser Support Team steht IThnen wahrend der Geschaftszeiten gerne zur Verfligung:
http://www.sellxed.com/support. Sie haben zudem jederzeit die Mdglichkeit unseren
Installationsservice zu bestellen. Wir sorgen flr eine reibungslose Installation in IThrem
Shop: http://www.sellxed.com/shop/de/integration-und-installation.html

.htaccess Verzeichnisschutz

Flr den Test des Zahlungsmoduls muss jeglicher Verzeichnisschutz oder IP Sperre auf
Ihrem Server zwingend ausgeschaltet sein, sonst kann es sein, dass das
Zahlungsfeedback von PayUnity nicht bis zu Ihrem Shop durchdringt.

1.2 System Anforderungen

Generell hat das Plugin die gleichen Anforderungen an das System wie OpencCart selber.
Nachfolgend finden Sie die wichtigsten Anforderungen des Plugins:

® PHP Version: 5.4.x oder hoher

® OpenSSL: Aktuelle Version mit Unterstltzung von TLS 1.2 oder hoher.

* fsockopen: Die PHP Funktion fsockopen muss zur Verfiigung stehen. Das Plugin muss
Verbindungen zu anderen Servern 0ffnen konnen.

PHP Funktionen: Im weiteren missen alle gangigen PHP Funktionen zur Verfiigung stehen.

Verwenden Sie OpenCart in der Version 3.0.3.5 oder 3.0.3.6, missen Sie ihren Store patchen, um
das Twig-Extension-Problem zu beheben. Dies kann bspw. mit der Installation der folgenden
Extension geldst werden: https://www.opencart.com/index.php?route=marketplace/extension
/info&extension_id=40469.
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2 Konfiguration
2.1 Grundkonfiguration des Hauptmoduls

Die Zugangsdaten fur die Testumgebung erhalten Sie von Payunity.

Navigieren Sie zum Hauptmodul in Ihrem Shop und tragen dort die folgenden Zugangsdaten ein:

® Authorization Bearer Token (Access Token)

® Entity ID (CHANNELID)

® Die Parameter User ID und User Password sind veraltet und werden nicht mehr bendtigt,
verwenden Sie stattdessen das Authorization Bearer Token.

* Den Parameter Security Sender und Security und Hash Secret bendtigen Sie flr die
vorligende Integration nicht mehr. Sie kénnen diese Eingaben einfach ignorieren.

nnnnnnn

Abbildung 2.1: Die Authorization Bearer Token Information im PayUnity Backend.

Daneben haben Sie noch weitere Eingabemadglichkeiten wie zum Beispiel die Custom Parameters
. Diese lassen Sie grundsatzlich leer ausser Sie werden von PayUnity zu einer Eingabe
aufgefordert.

2.2 Konfiguration Zahlungsarten

Um die Zahlungsarten zu aktivieren und weitere zahlartenspezifische Einstellungen
vorzunehmen, navigieren Sie zu deren Einstellungen. (Wo Sie diese finden wird sonst hier erklart.

Sie konnen in der Konfiguration der Zahlungsmethoden anhand der Regeln definieren, welche
Entity ID (Channel ID) flir welche Betrage verwendet werden soll. Dies ermdglicht Ihnen
beispielsweise flr kleinere Betrage einen non-3D Secure Channel zu verwenden. Flr das Set Up
und die entsprechenden Vertrage setzen Sie sich mit PayuUnity in Verbindung.
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Channel Conditions

Entity ID (MoTo)

COPYandPAY Style

Authorised status

Uncertain status

Captured status

Approved payment Status

Denied Payment Status

Authorisation Method

L L L R T T Ry e e

Beside the default channel 1D a set of channel IDs
depending on the order total amount can be defined.
Each line must contain a lower amount, an upper
amount and the applicable Channel ID. The format is
as follow "lower amount,upper amount,Channel D" as
shown in the following example:
*10.00;200.00;23413113213131231353". The upper
boundaries are not included. If you leave this field
empty or if an amount is outside any range the default
channel id is applied. If multiple conditions match the
last one is taken.

If this payment method should support recuring and
moto fransactions, you have to specify a second entity
1D without 30 secure.

Card
Define the style to be used for the COPYandPAY
payment form.

Ak

Complete

Ak

This status is set when the payment was successful
and it is authorised.

Cn Hold

ou can specify the order status for new orders that
have an uncertain authorisation status.

Ak

Ak

Don't change order status

You can specify the order status for orders that are
captured either directly afier the order or manually in
the back-end.

Complete

You can specify the order status for orders that are

Ak

approved after being in an uncertain state.

Canceled PayUnity

You can specify the order status for orders that are

Ak

denied after being in an uncerain state.

Server Authorization

Ak

Select the authorization method to use in order to
process this payment method.
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[STORE VIEW]
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Abbildung 2.1: Konfiguration der Zahlungsart am Beispiel Magento (Symbolbild, die Darstellung
kann bei Ihnen abweichen).

PCI: Neue Autorisierungsmethode Widget

Beachten Sie, dass die Verwendung des Hidden Mode an zusatzliche
Zertifizierungsanfoderderungen geknipft ist (vgl unser Blogeintrag zu diesem Thema).
Aus diesem Grund wird dieser in den neuen Versionen nicht mehr ausgeliefert. Sollten
Sie in Ihren Zahlmethoden noch den Hidden Mode verwenden. Nutzen Sie zuklnftig bitte
nur noch Widget. Der Hidden Mode Support wird in den kommenden Monaten eingestellt.

2.3 Konfiguration Webhook

In Ausnahmeféallen kann es passieren, dass die Zahlungsbenachrichtigung an Ihren Shop
fehlgschlagt, weil diese nicht bis zu IThrem Shop durchdringt oder der Kaufer den Browser
unmittelbar nach dem Kauf schliesst. Hierzu empfehlen wir ein sogenanntes Webhook im
PayUnity Backend unter Administration > Webbhook einzurichten. Bitte achten Sie darauf, dass
Sie die von unserem Modul dynamisch konfigurierte URL verwenden. Diese URL entnehmen Sie
dem installieren Modul in Ihrem OpenCart Shop unter Extensions > Modifications > Modules >
PayUnity Base Module > Edit > More > Setup.
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2.3.1 Konfiguration Webhook durch Handler

Wenn Sie das Webhook nicht durch PayUnity konfigurieren lassen kdnnen, mussten Sie bitte wie
wie oben beschrieben, die URL aus lhrem OpenCart Shop unter Extensions > Modifications >
Modules > PayUnity Base Module > Edit > More > Setup kopieren und das PayUnity Backend unter
Administration > Webbhook einfligen. Des weiteren muissten Sie bitte ein selbst festgelegtes
"secret for encryption” generieren und die Werte in die darauf folgenden Felder, wie auf dem Bild
unten zu Sehen, speichern.

Customweb "secret for encryption” Generator

Bitte beachten Sie, dass flr den Schlissel nur ASCII Zeichen verwendet werden ddrfen.
Damit Sie keine unerlaubten Zeichen benutzen, verwenden Sie bitte unseren Schlissel
Generator

Edit Webhook
4€7700C02B4CBIBDISTATAOL31a139

URL
Only ports 80 and 443 are guaranteed to work
Notiicaton Types. ‘Select notication types you want {0 receive:

PAYMENTS OarOaw@pabcsOcoOcpOcr@osDre0rerr0a ey

REGISTRATIONS @A

Fiekds o incude
ctve

Secretforencryption

Wirapper forencrypted notfcation

Abbildung 2.1: PayUnity Webhook Beispielkonfiguration in Ihrem Backend unter Administration >
webbhook.

2.3.2 Konfiguration Webhook durch PayUnity

Wenn Sie das Webhook durch PayUnity konfigurieren lassen konnen, missten Sie bitte wie wie
oben beschrieben, die URL aus Ihrem OpenCart Shop unter Extensions > Modifications > Modules
> PayUnity Base Module > Edit > More > Setup an PayUnity Gdbermitteln. PayUnity wird Ihnen
anschliessend ein sog. "secret for encryption" zustellen, welches Sie bitte in der
Hauptmodulkofniguration des Moduls speichern mussten.
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2.4 Aktivierung und Testing

Nach der Aktivierung und der Konfiguration der Zahlungsarten fiihren Sie einen Test mittels der
in der Anleitung publizierten Testdaten durch.

Sofern diese Tests erfolgreich verlaufen sind, schalten Sie den Operation Mode vom Testmodus
in den "Live Mode" und ersetzen die obigen Sicherheitsmerkmale durch lhre persdnlichen
Zugangsdaten flr die Live Plattform. Diese Daten erhalten Sie direkt von Ihrem Payment Service
Provider. In der Regel sollten USER ID etc fiir den Live Mode identisch sein.
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3 Modul Installation im OpencCart Shop
3.1 Installation

Sie sollten zu diesem Zeitpunkt bereits im Besitz des Moduls sein. Falls nicht erhalten Sie die
Moduldateien in Ihrem Benutzerkonto im sellxed Shop (MenlUpunkt "Meine Downloadartikel"). Um
das Modul in Ihrem OpenCart Shop zu installieren, fihren Sie bitte folgende Schritte durch:

1. Laden Sie das Plugin herunter. Den Download finden Sie in Ihrem sellxed.com Account
unter "Meine Downloadartikel".

. Entpacken Sie das Archive, welches Sie heruntergeladen haben.

. Im entpackten Ordner finden Sie einen Ordner "files"

. Flr einige Shops werden verschiedene Versionen des Plugins zur Verfligung gestellt.

. Laden Sie nun mit Ihrem preferierten FTP Programm den ganzen Inhalt dieses Ordners ins
Stammverzeichnis Ihres Shops. Bei gewissen Shops gibt es einen spezifischen Ordner,
welcher die Plugins enthalt. Sollte dies der Fall sein laden Sie das Plugin in diesen Ordner
hoch. Stellen Sie sicher, dass die Ordner nur zusammengefihrt werden und nicht ersetzt.

6. Falls nicht bereits geschehen, loggen Sie sich bitte in Ihrem Shop ein.

o &~ W N

3.2 Updates und Upgrades

wahrend der Supportdauer, erhalten Sie unbeschrankten Zugriff auf Updates und Upgrades in
Ihrem Kundenkonto. Um tber solche Updates informiert zu werden abonnieren Sie bitte den RSS-
Feed. Mehr Informationen hierzu finden Sie hier: http://www.sellxed.com/de/updates_upgrades.

3.2.1 Update Checklist

Bitte fihren Sie vor jedem Update folgende Schritte durch:
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1. Erstellen Sie immer ein Backup der Files und der Datenbank, bevor Sie mit dem Update
beginnen

2. Testen Sie das Update auf einem Testsystem. Wir testen die Module intern, es kann aber
sein, dass im Zusammenspiel mit anderen Plugins weitere Fehler auftreten.

3. Warten Sie bis die Files vollstandig auf den Server gespielt sind und besuchen Sie dann die
Konfigurationsseite des Hauptmoduls. Falls vorhanden leeren Sie bitte auch noch alle
Caches des Shopssystems

Je nach Update kann es sein, dass eine Datenbankmigration durchgefiihrt werden muss. Wir
empfehlen Ihnen daher, dass Update zu einem Zeitpunkt durchzufthren, an dem nicht zu viele
Kunden auf Ihrem Shop zugreifen.

Vorsicht bei Updates im Live Shop

Besondere Vorsicht ist bei Updates im Live Shop geboten. Testen Sie ein Update immer
zuerst in einem Testsystem. Unser Support Team hilft Ihnen gerne bei Problemen. Bei
Updates direkt im Live-System kann es jedoch zu unterbriichen kommen, welche je nach
Support Ressourcen bis zu 2 Tage dauern konnen.

3.2.2 Update Instruktionen

Bevor Sie das Update aufspielen, lesen Sie bitte die Update Instruktionen. Diese finden sich am
Ende der Pluginseite im Changelog. Sofern nichts weiteres in den Update Instruktionen steht,
konnen die Files einfach tberschrieben werden.
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4 Modul Konfiguration im OpenCart Shop

Die Konfiguration teilt sich in zwei Stufen. Der erste Schritt umfasst die Konfiguration des
Hauptmoduls mit den Grundeinstellungen (vgl. Konfiguration des Hauptmoduls). In einem
zweiten Schritt konnen fir jede Zahlungsart individuelle Konfigurationen vorgenommen werden.
Dies bringt Ihnen volle Flexibilitat und grosste Anpassung an Ihre Prozesse.

Erstellen Sie Backups!

Bitte erstellen Sie auf jeden Fall ein Backup des Hauptverzeichnises lhres Shops. Bei
Problemen kénnen Sie so jederzeit wieder zum Ursprungszustand zurtickkehren.

Im Weiteren empfehlen wir Ihnen die Integration zuerst auf einem Testsystem
durchzufthren. Es kann immer wieder zu Komplikationen mit von Ihnen installierten
Drittmodulen kommen. Bei Fragen steht Ihnen unser kompetenter Support gerne zur
Verfigung.
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5 Besonderheit OpenCart1.5x/2.0/3.0
Installation

Das Modul ist mit OpencCart 2.x und 1.5.x kompatibel. Achten Sie darauf, dass Sie die Dateien des
Ordners files_2.x verwenden, sollten Sie mit OpenCart 2 / MijoShop / AceShop arbeiten.
Verwenden Sie den Order files_1.x, wenn Sie OpenCart 1.5 als Basis nutzen.

Um einen reibungslosen Einsatz zu garantieren, mussen Sie einige Besonderheiten bei den
entsprechenden Versionen beachten.

5.1 Konfiguration des Hauptmoduls

Sie finden die Einstellungen des Hauptmoduls unter "Extension > Modules > PayuUnity Base
Module" . Installieren Sie das Modul indem Sie auf Install klicken.

Mit einem Klick auf Edit gelangen Sie in die Konfiguration des Hauptmoduls. Tragen Sie hier die
Daten in die einzelnen Felder ein. Die bendtigten Daten haben Sie entweder bereits im Backend
von PayUnity eingetragen oder von Payunity in vorheriger Korrespondenz erhalten. Jede Option
wird zudem mit einem kurzen Info Text im Shop nochamls erlautert.

5.2 OpenCart 2.0/ 3.0 - Refresh Modifications

Sollten Sie OpenCart 2.0 verwenden ist es wichtig, dass Sie die Modifications refreshen. Dazu
gehen nach Module > Modifications. Oben Rechts finden Sie den Button refresh. Mit dem Klick
darauf konnen Sie die Modifikationen neuladen. Stellen Sie sicher, dass der Ordner system >
modifications Schreibrechte besitzt.

5.3 Besonderheit OpenCart 1.0 Installation

Sollten Sie OpenCart 1.0 verwenden, dann bendtigen Sie die Extension VQMOD. Weitere
Informationen zur Installation und zum Projekt finden Sie unter https://github.com/vamod
/vamod/wiki/Installing-vQmod-on-Opencart

5.4 Konfiguration der Zahlungsart

Nachdem das Hautpmodul erfolgreich konfiguriert wurde, finden Sie unter EXtensions >
Payments die Einstellungen zu den einzelnen Zahlungsarten in Ihrem Shop. Jede Zahlungsart
wird Ihnen einzeln aufgelistet. Installieren Sie jene Zahlungsmethoden, welche Sie Ihren Kunden
anbieten mdchten. Sie kdnnen flr jede Zahlungsart individuelle Einstellungen vornehmen und so
die Zahlung optimal an Ihre Prozesse anpassen. Die zentralen Optionen werden in der Folge
genauer erldutert.

Mit dem Klick auf Install wird eine Zahlungsmethode in Ihrem Shop installiert. Klicken Sie auf Edit
um die Konfiguration der Zahlungsart anzupassen.
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5.5 Direktes Verbuchen von Bestellungen

Mit der Option "Buchung" legen Sie fest, ob Zahlungen direkt verbucht, oder zuerst autorisiert
werden. Sofern Sie in einem ersten Schritt nur autorisieren mochten, stellen Sie sicher, dass die
Zahlungen spater verbucht werden.

Eine Reservation ist, abhangig von Ihrem Acquiring Vertrag, nur eine gewisse Zeit garantiert.
Sollten Sie in dieser Zeit nicht verbuchen, kann es sein, dass die Autorisierung nicht mehr
garantiert wird. Weitere Informationen zum Prozess der Verbuchung finden Sie weiter unten.

Unterschiedliche Einstellungen zwischen Payunity - Backend und
Modul

Es kann sein, dass die Einstellungen im Modul flr die Zahlungsweise Ihre Einstellungen
im Backend von PayUnity einfach Uberschreiben.

5.6 Unsicherer Status

Sie kénnen Bestellungen, flir welche die Zahlung noch nicht garantiert werden kann, speziell
markieren. Dies erlaubt Ihnen diese Bestellung vor dem Versand noch einmal manuell zu prifen.

5.6.1 Setzenvon Order-Status

Sie konnen fiur jede Zahlungsart festlegen in welchen Status die Bestellung je nach
Buchungsstatus verschoben werden soll. Es handelt sich hier um den initialen Status der
Bestellung.

5.7 Optional: Validierung

Mit der Validierung steuern Sie den Zeitpunkt wann eine Zahlungsart im Checkout angezeigt
werden soll. Diese Einstellung ist flir Module relevant bei denen die Benutzung von
Voraussetzungen lhres Kunden abhangig ist. Beispielsweise wenn noch eine Bonitatsprifung
erfolgen soll, oder die Zahlungsart nur in gewissen Landern verfugbar ist. ES kann sein, dass
diese Einstellung bei Ihnen nicht ersichtlich ist. Dann Uberspringen Sie diesen Punkt. Damit die
Bonitatsprifung beziehungsweise Adressvalidierung auch mit europaischen Zeichen
funktioniert, muss bei gewissen PSP-Einstellungen das Charset des "Blowfish mode" auf "UTF-8"
gesetzt werden.

Sollte die Einstellung ersichtlich sein, haben Sie die Wahl zwischen folgenden Optionen:

¢ Validierung vor Auswahl der Zahlungsmethode: Es erfolgt vor der Auswahl der Methode
eine Validierungsprifung. Sofern die Voraussetzungen nicht erflllt sind, wird die
Zahlungsart nicht angezeigt.

¢ Validierung nach der Auswahl der Zahlungsmethode: Die Priifung der Voraussetzung
erfolgt nach der Wahl und vor der Bestatigung der Bestellung.
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e Wahrend der Autorisierung: Die Validierungsprifung erfolgt durch PayUnity wahrend dem
Autorisierungsprozess. Die Zahlungsmethode wird auf jeden Fall angezeigt.
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6 Einstellungen / Konfiguration von
Zahlungsarten

6.1 Allgemeine Informationen zu den Zahlungsarten

Das Plugin wird mit einer grossen Auswahl von Zahlungsarten ausgeliefert. Sollte eine
Zahlungsart nicht verfligbar sein, bitten wir Sie sich mit uns in Verbindung zu setzen.

Flr die Nutzung einer Zahlungsmethode muss die Zahlungsart in Threm Konto bei PayUnity und
im Shop aktiviert sein. Informationen zur Konfiguration des Zahlungsmoduls finden Sie weiter
oben.

In den folgenden Punkten finden Sie wichtige Informationen zu bestimmten Zahlungsarten, die
sich vom Standard unterscheiden.

6.2 Informationen zum Zahlungszustand

Sie kbnnen fir jede Zahlungsart den initialen Zahlungsstatus individuell definieren (Status fir
autorisierte Zahlungen etc). Dabei definieren Sie den Zahlungsstatus fur die einzelnen Zustande
abhangig von der Verarbeitungsart der Bestellung (verbucht, autorisiert, etc.). Es handelt sich
dabei um den initialen Status, welcher die Bestellung annimmt. Abhdangig von der durch Sie
durchgefihrten Mutationen kann sich der Status andern.

Wichtige Info bezlglich dem Bestellstatus

Setzen Sie den Status nie auf Pending PayUnity oder einen dhnlich lautenden pending
status, der durch das Modul eingefthrt wird.

6.2.1 Bestellstatus "ausstehend" / bevorstehende Zahlung (oder ahnlich)

Bestellungen mit dem Status 'pending PayUnity' sind pendente Bestellungen. Der Status wird
gesetzt, wenn der Kunde flr die Zahlung umgeleitet wird aber nicht erfolgreich zurtickkehrt oder
das Feedback nicht bis zu IThrem Shop gekommen ist (Kunde hat das Fenster auf der Payment
Page geschlossen und die Zahlung nicht abgeschlossen). Abhangig von der Zahlungsart werden
diese Bestellungen automatisch in abgebrochene Bestellungen umgewandelt und der
Lagerbestand wieder freigegeben (sofern der Cronjob Aktiviert ist). Diese Zeitspanne hangt von
den Eigenheiten der Zahlungsart ab, und kann nicht konfiguriert werden.

wenn Sie eine Vielzahl ausstehender Bestellungen haben, deutet dies in der Regel darauf hin,
dass die Notifikationen von Ihrem Webserver zu PayUnity blockiert werden. In diesem Fall
uberprifen Sie die Einstellungen Ihrer Firewall und bitten den Hoster die IPs und User Agents von
PayUnity zu aktivieren.
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6.2.2 Abgebrochene / stornierte Bestellungen

Bestellungen, die als abgebrochen markiert werden, wurden wie oben beschrieben automatisch
in diesen Status aufgrund des Timeouts versetzt. Abgebrochen werden aber auch alle
Bestellungen, welche von den Kunden aktivabgebrochen wurden.

6.3 Klarna

Sie kbnnen Klarna direkt Gber Payunity abwickeln. Wir gehen in der Folge auf die Besonderheiten
des Klarna Setups ein.

6.3.1 Unterstitzte / Nicht unterstitzte Funktionen
Das Modul unterstitzt folgende Funktionen nicht:

® Eskonnen keine Bestellungen im Backend von OpenCart angelegt oder verandert werden.

* Teilaktivierungen und Teilgutschriften kénnen nur direkt aus dem Backend von PayUnity
https://payunity.com/bip/login erstellt werden. Aktivierungen oder Gutschriften der
gesammten Rechnung sind innerhalb von OpenCart mdglich. Mehr Informationen dazu
finden Sie im Kapitel Transaktionsmanagement.

Bearbeiten von Klarna Transaktionen in OpencCart

Bitte beachten Sie, dass Sie in keinem Fall eine Klarna Transaktion in OpenCart
bearbeiten durfen.

Die restlichen Funktionen konnen durch das Modul durchgeflihrt werden. Im Folgenden finden
Sie eine Beschreibung der wichtigsten Funktionen.

6.3.2 Set UP/Einrichten der Zahlart

Aktivieren Sie die Zahlart an gewohnter Stelle. Beachten Sie bitte folgendes bei der Installation:
6.3.2.1 Anpassen des Anzeigenamens der Zahlart

Den angezeigten Namen im Frontend andern Sie unter Titel. Bitte verwenden Sie den Titel
Rechnung flr die Zahlart. Im Weiteren definieren Sie unter Anzeigen des Logos, ob das Klarna
Logo dem Kunden im Frontend entsprechend angezeigt wird.

6.3.2.2 Anpassen der Zahlartbeschreibung

Die Beschreibung der Zahlart konnen Sie unter Description andern. Bitte hinterlegen Sie hier
folgenden Text: "In 14 Tagen bezahlen".
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6.3.2.3 Wahl der Autorisierungsmethode

Wir empfehlen IThnen die Autorisierungsmethode in der Zahlart auf Server einszustellen. In
diesem Fall findet keine Weiterleitung auf die Payment Page von PayUnity statt und Sie kdnnen
im Shop den gesamten Checkout Flow kontrollieren.

6.3.2.4 Klarna Merchant ID

Tragen Sie in den Einstellungen der Zahlart die Klarna Merchant ID ein. Diese erhalten Sie
entweder direkt von Payunity oder finden Sie in Ihrem Klarna Vertrag.

6.3.3 Stornieren der Rechnung

Wie Sie Rechnungen stornieren kdnnen, wird weiter unten im Kapitel Verbuchen / Stornieren von
Bestellungen beschrieben. Mehr Informationen dazu finden Sie im Kapitel
Transaktionsmanagement.

Verzogerte Rechnungsaktivierung

Beachten Sie, dass Sie in der Einstellung der Zahlart sicherstellen missen, dass die
Rechnungserstellung auf verzogert eingestellt werden muss, damit Sie die Rechnungen
in OpencCart aktivieren kdnnen.

6.3.4 Aktivierung von Rechnungen

Wie Sie Rechnungen aktivieren (verbuchen) kénnen, wird weiter unten beschrieben. Mehr
Informationen dazu finden Sie im Kapitel Transaktionsmanagement. Teilaktivierungen sind nur
im BIP von Payunity moglich.

Verzogerte Rechnungsaktivierung

Beachten Sie, dass Sie in der Einstellung der Zahlart sicherstellen mussen, dass die
Rechnungserstellung auf verzogert eingestellt werden muss, damit Sie die Rechnungen
in OpenCart aktivieren kdnnen.

6.3.5 Teilgutschriften und Teilaktivierungen

Teilgutschriften und Teilaktivierungen kénnen nur direkt im BIP von PayUnity durchgeflihrt
werden.
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6.3.6 0n Hold Bestellungen (Pending)

Pending Bestellungen werden vom Modul nicht unterstitzt. Damit diese vom System richtig
gehandelt werden, missen Sie im BIP flr die Zahlungsart Klarna das "Status Check interval" Feld
leerlassen. Bitte wenden Sie sich an PayUnity um diese Einstellung vorzunehmen.

Sofern Sie dieses Szenario testen mochten, verweisen wir hier auf die Testinformationen von
Klarna (vgl. unten)
6.3.7 Testing

Um die Zahlart Klarna zu testen, sollten spezielle Testdaten verwendet werden. Stellen Sie aber
zuerst sicher, dass der Operation Mode auf Test ist und der Testmode auf External.

Die offiziellen Testdaten von Klarna finden Sie direkt im Developper Portal von Klarna unter
diesem Link: https://developers.klarna.com/en/de+php/kpm/test-credentials.

6.3.8 Zahlungsgebihren

Sofern Sie Zahlungsgeblhren flr eine Zahlart erheben madchten, nutzen Sie bitte die
kompatiblen Zahlungsgeblhren Module. Diese Gebidhren werden dann direkt an Klarna
Ubertragen.

Zahlungsgebuhren

Bitte beachten Sie, dass Sie keine Zahlungsgebthren im BIP von Payunity setzen dirfen.
Daflir nutzen Sie bitte die kompatiblen Zahlungsgebihren Module.
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7 Das Modul in Aktion

In der Folge finden Sie eine Ubersicht tiber die wichtigsten Funktionen im téglichen Gebrauch
des PayUnity Moduls.

7.1 Nutzliche Transaktionsinformationen zur Bestellung

Sie finden in jeder Bestellung, die mit unserem Modul abgewickelt wurde, eine Ubersicht iber
die wichtigsten Informationen zur Transaktion. Unter anderem erauben diese Informationen die
eindeutige Zuordnung der Bestellungen zu den Transaktionen, welche Sie bei PayUnity im
Backend sehen.

D Orders
Order Details OrderiD #2
T Invoice No. [ Generate ]
Shipping Details Store Name: Your Store
Products Store Url: hitpidemo.sellxed.comius
History Customer: Sascha kriisi

Customer Group: Default
E-Mail: info@customweb.ch
Telephone 33123456798
Total: 78.90€
Order Status: Pending
IP Address: 160.85.155.47
User Agent Mozilla/5.0 (X11; Linux x86_64) AppleWebKit/537.36 (KHTML, like Gecko) Ubunty Chromium/30.0.1599.114 Chrome/30.0.1599.114 Safari/537.36
Accept Language: de.en-US:q=06en:q=0.6
Date Added: 13/11/2013
Date Modified: 13/11/2013

Abbildung 7.1: Transaktionsinformationen in OpencCart.

7.2 Nutzung des Alias Managers / Token LOsung

Mit dem Alias Manager konnen Kreditkarten Ihrer Kunden flr spatere Einkdaufe sicher bei
PayUnity gespeichert werden. Die Nutzung wird aktiviert indem Sie die Option "Alias Manager" in
der Konfiguration der Zahlungsart aktivieren. Fur spatere Einkaufe kann der Kunde zwischen den
bereits gespeicherten Karten wahlen und muss so nicht die gesamte Karte nochmals erfassen.

Use Stored Card | xxox 000000 0111 ¥

Card Holder Name*  Sascha kriisi

Please enter here the card holder name on the card.

Card Number* 0000 0000 00 0111
Please enter here the number on your card.

Card Expiration* 12 v 2015 ¥

Select the date on which your card expires.

CVC Code”

Please enter here the CVC code from your card. You find the code on the back of the card.

‘Confirm Order
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Abbildung 7.1: Alias Manager

Alias Manager Optionen

Die Nutzung des Alias Mangers ben0tigt die Freischaltung der entsprechenden Option bei
Payunity. Nenmen Sie daflr bitte direkt mit dem Support kontakt auf.

7.3 Verbuchen/ Stornieren von Bestellungen

7.3.1 Verbuchen von Bestellungen

Um Bestellungen zu verbuchen, 6ffnen Sie den Transaktionsmanager unter Sales > Payunity
Transactions. Hier finden Sie eine Ubersicht (iber alle Transaktionen. Suchen Sie Die Bestellung
im Feld der Bestellnummern. Mit "view" 0ffnen Sie die Transaktion zur Bestellung.

7.3.1.1 Verbuchen kompletter Bestellungen oder Teilverbuchung (partial Capturing)

Durch den Klick auf den Button "Capture Transaction" 6ffnet sich ein neues Eingabefeld. Sie
konnen nun jeden Artikel einzeln verbuchen, sofern Sie nicht alle Artikel auf einmal versenden
kénnen. Die Anzahl der Verbuchung von Teilbetragen hangt von Ihrem Vertrag ab. Erkundingen
Sie sich diesbeziglich direkt bei PayUnity.

Verbuchung von Bestellungen im Backend von Payunity

Das Transaktionsmanagement zwischen PayUnity und Ihrem Shop ist nicht
synchronisiert. Wenn Sie Zahlungen im Backend von PayUnity verbuchen, wird der Status
im Shop nicht angepasst und ein zweites Verbuchen im Shop ist nicht méglich.

Falls Sie nicht alle Artikel der Bestellung verbuchen wollen, konnen Sie die Transaktion durch
anklicken des Kastchens auch flr spatere Verbuchungen schliessen.
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With the following form you can perform a partial capture.

Name SKU Type Tax Rate
iPhone product 11 product 0%
Flat Shipping Rate shipping shipping 0%

Abbildung 7.1: Verbuchen von Bestellungen.

Partial Capturing

Quantity Total Amount (excl. Tax) Total Amount (incl. Tax)
1 | 74.24 | 74.24
1 | 3.68 | 3.68

Total Capture Amount: 77.91 EUR

Close transaction for further captures

Capture

Erkundigen Sie sich, ob mehrere Verbuchungen von PayUnity in Ihrem Vertrag unterstitzt
werden. Sonst kann es vorkommen, dass die Transaktion bei einer Teilverbuchung fir

spatere Verbuchungen geschlossen bleibt.

7.3.2 Bestellungen stornieren

Mit dem Klick auf "Cancel Transaction" erfolgt ein Storno der Transaktion und der reservierte

Betrag wird auf der Karte Ihres Kunden sofort freigegeben.

Capture Transaction

Abbildung 7.1: Capture oder Cancel in OpencCart.

Refund Transaction

7.4 Ruckvergiuten von Bestellungen

Um Bestellungen riickzuverguten, 6ffnen Sie die Transaktionsinformationen (vgl. oben).

Sie kénnen jeden einzelnen Artikel oder einen beliebigen Betrag rickerstatten indem Sie die

Totalbetrage oder die Anzahl Artikel anpassen.
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PARTIAL REFUND

With the following form you can perform a partial refund.

MName SKU Type Tax Rate Quantity Total Amount (exel. Tax) Total Amount (incl. Tax)

iPhone product11  product 0% | 1 | 74.24 [ 7424

Flat Shipping Rate shipping shipping 0% I 1 I 3.68 I 368
Total Refund Amount: 7791 EUR

Close transaction for further refunds

Abbildung 7.1: Refunds in OpencCart flr Payunity.

Maximaler Refund

Mit unserem Zahlungsmodul kdnnen Sie nie mehr als 100% des urspringlich
autorisierten Betrages zuruckerstatten.

Durch das Ausfuhren einer Gutschrift verandert sich der Zustand der Bestellung nicht.

7.5 Einrichten CronJob

Um die zeitgesteuerten Funktionen des Plugins zu aktivieren (bspw. Update Service, Loschen
pendenteter Bestellungen, etc.) mussen Sie in OpenCart Cron Jobs einrichten. Insbesondere die
Update funktion erméglicht Ihnen nachtragliche Anderungen der Transaktion bei Payunity Giber
die APl abzuholen (Bitte beachten Sie, dass es sein kann, dass hier zusatzliche Optionen
freigeschaltet werden muissen.

Damit die zeitgesteuerten Aktionen durchgefihrt werden richten Sie bitte einen Cron Job in
Ihrem Server auf folgenden Controller ein:

https://www.your-shop.com/index.php?route=payunitycw/cron/cron

Wir empfehlen Ihnen hier eine Cron Engine wie beispielsweise EasyCron. Damit kdnnen Sie die
Datei (URL) mit einem externen Service aufrufen
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Bevor Sie vom Test Modus in den Live Modus wechseln, sollten Sie das Modul ausfihrlich testen.

Testen

Vergessen Sie nicht, nach erfoglreichem Testing den Betriebsmodus von Test auf Live

umzustellen.

8.1 Testdaten

Nachfolgend finden Sie die Testdaten fur die Zahlungsmethoden:

American Express

Kartennummer
Verfallsdatum
CVC:

Kartennummer
Verfallsdatum
CVC:

Carte Bleue
Kartennummer
Verfallsdatum
CVC:

Dankort
Kartennummer
Verfallsdatum
CVC:

Diners Club
Kartennummer
Verfallsdatum
CVC:

Sepa Direct Debits

[BAN
BIC

[BAN
BIC

[BAN
BIC

Discover Card

377777777777770
12/2020
123

375987000000005
12/2020
123

5555555555554444
12/2020
123

5019717010103742
12/2020
123

36961903000009
12/2020
123

AT152011128161647502
GIBAATWWXXX

DE23100000001234567890
MARKDEF1100

ES9121000418450200051332
CAIXESBBXXX

No 3D Secure

3D Secure

Austria (AT)

Germany (DE)

Spain (ES)
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Kartennummer
Verfallsdatum
CVC:

giropay
IBAN
BIC

[BAN
BIC

[BAN
BIC

JCB
Kartennummer
Verfallsdatum
CVC:

Klarna Invoice

Maestro
Kartennummer
Verfallsdatum
CVC:

MasterCard
Kartennummer
Verfallsdatum
CVC:

Kartennummer
Verfallsdatum
CVC:

Visa
Kartennummer
Verfallsdatum
CVC:

Kartennummer
Verfallsdatum
CVC:

Kartennummer
Verfallsdatum

6011587918359498
12/2020
123

AT152011128161647502
GIBAATWWXXX

DE23100000001234567890
MARKDEF1100

ES9121000418450200051332
CAIXESBBXXX

3541599999092431
12/2020
123

6799851000000032
12/2021
123

5454545454545454
12/2021
123

5212345678901234
12/2021
123

4200000000000000
12/2020
123

4012001037461114
12/2020
123

4000000000000010
12/2021

sellxed

Austria (AT)

Germany (DE)

Spain (ES)

Klarna (Approved)
Klarna (Denied)
Klarna (Pending -> Approved)

Klarna (Pending -> Denied)

No 3D Secure

3D Secure

No 3D Secure

3D Secure

3D Secure 2.0
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CVC:

V PAY
Kartennummer
Verfallsdatum
CVC:

123

4822000000000000003
12/2020
123

sellxed
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9 Fehler und deren Losungen

Sie finden ausfihrliche Informationen unter http://www.sellxed.com/de/faq. Sollte sich Ihr
Problem mit den zur Verfligung gestellten Informationen nicht 16sen lassen, melden Sie sich
bitte direkt bei uns: http://www.sellxed.com/de/support

9.1 Die Referrer URL erscheint in meinem Analytics Tool

Unter Umstanden kann die Referrer URL von PayUnity falschlicherweise im Analytics Tool
erscheinen. Dies passiert, wenn der Kunde mit einer HTTP Header Weiterleitung zurick in den
Shop geleitet wird. Die meisten Analytic Tools kdnnen dieses Problem jedoch minimieren, indem
die entsprechende URL aus dem Report ausgeschlossen wird.

FUr Google Analytics hilft dieses Step-by-Step Guide am Beispiel von PayPal: Weitere Infos sind
unter Punkt 4 beschrieben.
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10 Kompatibilitat zu Third-Party Plugins

Unten aufgefliihrte Plugins sind kompatibel mit unseren Zahlungsmodulen und erleichtern Ihnen
in gewissen Bereichen die Arbeit.

10.1 Geburtstag und Geschlecht in OpenCart

Flr gewisse Zahlungsanbieter ist es n6tig den Geburtstag sowie das Geschlecht des Kunden zu
prifen. OpenCart tut dies standartmassig nicht.

Geburtstag und Geschlecht Abfragen in ihren Checkout einfigen

1. Fugen Sie dem Checkout Ihres Shops zwei neue Custom Fields hinzu. Dies konnen
Sie im Backend Ihres Shops unt ""Customers > Custom Fields" tun.

2. Modifizieren Sie dann die "order context getters" so, dass diese den Wert der Order
/ Session (oder wo immer der vorgangige Schritt die Daten speichert) zurtick
deben.

Order Context Getters

* AbstractOrderContext
* getBillingDateOfBirth()
e getBillingGender()

Diese Funktionen finden Sie in "system/library/cw/PayuUnity/AbstractOrderContext.
phpll.
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11 Error Logging

Das Modul logged verschiedene unerwartete Fehler und sonstige Fehler abhangig vom
konfigurierten Logging Level. Sollte es ein Problem mit dem Modul geben kann das Log Hinweise
auf dessen Ursache liefern.

11.1 Log Levels

Sie kdnnen das Log Level in den Einstellungen von PayUnity konfigurieren.

® Error: Logt nur unerwartete Fehler. (Standart)
* |nfo: Logt zusatzliche Informationen.
* Debug: Logt debugging relevante Informationen.

11.2 Pfad der Log Datei

Die Log Datei wird standarmassig im Log Ordner von OpencCart gespeichert. Der Pfad wir in der
config.php Ihres Shops gespeichert. (Standart Pfad: {shopRootDirectory}/system/logs oder
{shopRootDirectory}/system/storage/logs)
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12 Erweiterte Informationen

Dieser Abschnitt des Manuals beinhaltet Informationen fir Anwender mit speziellen
Anforderungen. Samtliche hier aufgefiihrte Informationen und Konfigurationen sind optional

und flr die normale Verwendung des Plugins nicht erforderlich.

12.1 Transaction Object

In diesem Abschnitt finden Sie Informationen wie Sie Daten zu einer Transaktion aus
Datenbank auslesen kdnnen um diese, z.B. in einem ERP System, weiter zu verarbeiten.

der

Fir die Code Snippets in diesem Abschnitt wird angenommen, dass sich Ihr Script im

Stammordner des Shops, in einer Standart Ordnerstruktur befindet.

In your script initialize the base of OpenCart.
Opencart 3.X

requi re_once(' config. php');

requi re_once(Dl R_SYSTEM . 'startup.php');
/'l Registry

$registry = new Registry();

/'l Config

$config = new Config();

$confi g->l oad(' default');

$config->l oad(' catal og');

$regi stry->set (' config', $config);

$l oader = new Loader ($registry);

$registry->set('load , $loader);

$regi stry->set (' db', new DB($config->get('db_type'), $config->get
('db_hostnane'), $config->get('db _usernane'), $config->get

(' db_password'), $config->get('db_database'), $config->get('db _port')));

Include the module specific files and set registry.

requi re_once DIR_SYSTEM 'library/cwinit.php';

require_once DIR SYSTEM ' |ibrary/cw PayUnityCOw Uil . php';

requi re_once DIR_SYSTEM ' library/cw PayUnityCw Entity/ Transacti on. php'
PayUni tyCw Util::setRegistry($registry);

Now you can load the transaction and then extract the transactionObject.
Load the transaction by Id:

$transactionByld = PayUnityCw Entity_Transaction::|oadByld
($transactionld);
$transacti onChj ect = $transacti onByl d->get Transacti onCbj ect () ;

Load transactions by Order ID:
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$transactionsByOrderld = PayUnityCw Entity_Transaction::

get Transacti onsByOrder | d( $orderld);

foreach($transacti onsByOrderld as $transaction){
$transacti onObj ect = $transacti on->get Transacti onObj ect ();
/1 Do sonething with each object
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